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Copy and Paste: Select an object and hold alt (PC) or option (Mac) and drag, this will copy the 

object you’ve selected.

Copy and Paste in Front: [ctrl+c] (PC) or [command+c] (Mac) to copy and then [ctrl+f] (PC) or 

[command+f] (Mac) to paste in front.

Copy and Paste in Back: [ctrl+c] (PC) or [command+c] (Mac) to copy and then [ctrl+b] (PC) or 

[command+b] (Mac) to paste behind.

Copy Object and Repeat Spacing: Select an object and hold alt (PC) or option (Mac) and drag, 

this will copy the object you’ve selected and the spacing of which you dragged. Then hit 

[windows key+d] (PC) or [command+d] (Mac) to copy the same command. This is a great 

shortcut for when you’re creating multiple objects.

SECTION 1:
TOOLS & WINDOWS

INTRODUCTION

COMMANDS

If you delete a window from your dashboard or it’s not 

showing, go to Window in your top menu and choose 

the window you’d like to view. There are many different 

window options. As you become more familiar with the 

program, you can customize the windows you use most 

often to your dashboard.

QUICK TIP: I find that the only window I need that isn’t defaulted to my dashboard is the Type 
window. You can edit the style of type, height, spacing, and much more from this window. It’s 
convenient for making custom calligraphy to fit an image.

YOUR TOOLS & WINDOWS MAKE UP THE ACTIONS WITHIN YOUR DASHBOARD. TOOLS ARE

HOUSED ON THE LEFT WHILE WINDOWS ARE DOCKED ON THE RIGHT. IN ORDER TO 

PERFORM ACTIONS WITHIN ILLUSTRATOR YOU WILL USE YOUR TOOLS OR WINDOWS.
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Shortcut: [p]

Description: Used to make paths and anchor points that make up an object.

Function:

• Click to add anchor point, drag mouse to add second anchor point, and so on

• Click and hold then drag mouse to create a curved path

• To exit use shortcut [Command/Ctrl + click]

• Click and hold pen tool in menu to access other tool functions 

• Add Anchor Point Tool [+] : Add another anchor point on any segment of 

   your path

• Delete Anchor Point Tool [-] : Delete any anchor point on a path

Shortcut: [v]

Description: Used to select objects.

Function: 

• Click, hold, and drag to select a group of objects

• Click to select an object or a group

• Double click to isolate a group and manipulate the objects within it

Shortcut: [a]

Description: Used to select anchor points.

Function:

• Click on an anchor point and drag to move its position

• Click on a section between two anchor points to move its position

• Click on an anchor point to reveal handles, use handles to change the curve 

   of a path

Shortcut: [\]

Description: Used to create straight paths comprised of two anchor points.

Function:

• Click once to create line parameters

• Click, hold, and drag to draw straight to second anchor point, let go to end path

TOOLS
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Shortcut: [m]

Description: Used to create shapes that are made up of paths and anchor points.

Function: 

• Click and drag to desired size

• Click and hold shift to make symmetrical

• Click and input desired width and height

• Polygon, Rounded Rectangle, Star: Click, drag, and hold – use up and down 

   arrows to change the number of anchors or level of roundness (for Rounded 

   Rectangle)

Shortcut: [c]

Description: Used to cut a path.

Function:

• Select cut tool, click on any point of a path

Shortcut: [h]

Description: Used to move the canvas, use in place of scrolling.

Function:

• Select hand tool, click and drag to desired location

Shortcut: [z]

Description: Used to zoom in and out of the canvas.

Function:

• Select zoom tool, click to zoom in

• Hold option (Mac) or alt (PC) and click to zoom out 

• Click and hold, drag mouse to the right to zoom in, drag mouse to the left to 

   zoom out of one central spot

TOOLS
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Description: Used to combine shapes in different ways, eliminates the need to 

go through and delete multiple anchors, easily create compound paths.

Function: 

• Layer shapes on top of each other, highlight both (or more) objects with the 

   select tool [v], then choose from divide, trim, merge, etc. to achieve the 

   desired shape

Description: Used to color the path of a line/object and fill the interior of an 

object with color.

Function:

• Select your object with the select tool [v] or direct select tool [a], go to 

   swatches panel, choose color

• Switch between line color (black outlined box above) and fill color (white 

   filled box with red line through it above) by clicking the respective box. 

Shortcut: [shift+o]

Description: Used to add, move, scale, select, and delete artboards. Artboards 

represent what will print from your canvas.

Function:

• Select artboard tool, click and drag to create a custom sized artboard

• Use anchor points along edge to resize an existing artboard

• Click on existing artboard to move around canvas

• Click and press delete on keyboard to remove

• Use Artboard window to manage artboards: delete, add, and manipulate size

Description: Used to create different layers within the document.

Function:

• Create a new layer by clicking the “Add Layer” button at the bottom of the 

   window

• Add, delete, lock, and hide layers in the Layers window

• To move object between layers: select object, click on the new layer created, 

   right click (PC) on object or [control+click] (Mac), select Arrange > Send to 

   Current Layer

WINDOWS
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Description: Used to change the style or width of a path.

Function:

• Select path with the select tool [v] or direct select tool [a], go to stroke 

   panel

• Change the width of a path with “Weight”

• Change the style of the end of a path (anchor point) with “Cap”

• Change the style of a corner of a path (anchor point) with “Corner”

• Click the “Dashed Line” box to create a dashed line, change the width of 

   the dash and gap by entering a value in the box below, the ideal values for 

   a stitch line are 1.5 dash and 1.5 gap

• Add an arrowhead to a line with the dropdown “Arrowhead” menu, can be

  added to either side of a path

• Use “Profile” to change the style of a path

Description: Used for drawing using a guideline.

Function:

• Choose View from the menu at the top, choose show grid to add a grid to 

   the background of your canvas (this will not print or interfere with your 

   objects)

• Choose View from the menu at the top, choose show rulers to add rulers 

   to the top and left side of your template (change the unit of measure by 

   going into document setup)

• Click in the ruler and drag to bring out a guide: lock, delete, and hide 

   guides by going to View > Guides

WINDOWS
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SECTION 2:
SCALE

1/8 SCALE

PROPORTIONAL SCALE

BLOCKS
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When drawing to scale, 1/8 scale is most commonly used. Other scales such as ¼ or ½ scale may 

be used when drawing infant apparel or certain accessories. When using 1/8 scale always have 

your grid showing (view > show grid) because each box is 1/8” tall by 1/8” high. This means that 

when drawing a garment to scale each grid box is equal to 1”. To draw your garment to scale, you 

must first measure your garment and fill out a POM sheet. With your measurements handy, you 

can begin marking out the dimensions of your garment with guides (or lines on a separate layer). 

Often, drawing in 1/8 scale will leave your sketch looking odd because you are taking a 3D object

 and portraying it in 2D.

In the Industry proportional scale is most commonly used. It is much easier, faster, and looks more 

true to the garment. There is less need to update the sketch throughout the life-cycle of the 

product because it is only updated for design changes, instead of for every measurement change.

To draw proportionately, start by looking at the garment flat and begin marking out the outline 

and other prominent factors. It can be helpful to have a few basic measurements (height, width, 

etc.) to establish the proportion. You can also take a picture of the garment laying flat, copy and 

paste it into your document, put it on a new layer, and draw over the top of it. I find this method 

the most effective. 

Once you’ve established your basic proportion you can use it as a block going forward to create 

consistency among your sketches. A block library will consist of outlines only and possibly a few 

details that you use consistently. You can save your block library as a regular AI file. To use, open 

the AI file, choose your block, copy and then paste it into your new document.



Begin with the outline of your garment, you can always manipulate 

it later. Draw half of the garment only with it split in the middle, 

vertically.

QUICK TIPS:
• When creating a curve, intersect your middle guide at 90 degrees. 
   This ensures a smooth curve when you connect your points. 
   See: neck and hem
• Start your outline at 2pt line width
• Do not add any details, yet.

Select your object and right click (PC) or [control+click] (Mac) then 

choose Transform > Reflect. Select “Vertical” and click Copy. Click the 

new copy and drag to the other side of the guide holding shift to keep 

it level.

To join the two objects, select both and right click (PC) or 

[control+click] (Mac), select Join. Repeat: right click (PC) or 

[control+click] (Mac), select Join to join both the top and bottom.

QUICK TIPS:
•Does it look proportional? Make any changes necessary to the shape, 
  but always make the same changes to both sides.

SECTION 3:
FLATS INTRODUCTION

HOW TO DRAW A FLAT SKETCH
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Begin adding details to one side only. 

QUICK TIPS:
• Hems inside the shape = 1pt line weight
• All seams inside the shape = .75pt line weight
• All stitch lines = .5pt dashed line at 1.5pt dash and 1.5pt gap



Repeat the steps above to reflect the details and connect the shapes.

Highlight all parts of the drawing and right click (PC) or 

[control+click] (Mac), select Group. Now the sketch is grouped and can 

be moved entirely with all of the parts attached. If you’d like to edit the 

sketch more you can right click (PC) or [control+click] (Mac) and select 

Ungroup. Or if you’d like to keep the sketch grouped, you can double 

click the object to isolate its parts. 

Now you have a complete flat sketch!

To draw the back of the garment, copy and paste your outline. Then, 

follow the same steps as above to add the details of the back.

HOW TO DRAW A FLAT SKETCH
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Movement lines are sometimes necessary to show the drape of the 

fabric. It really depends on what your personal style is or what you’re 

trying to convey. In my experience, movement lines are used best to 

illustrate volume, darts, pleats, or ruffles. However, some schools of 

thought want them included on every sketch. This can be problematic 

when sending sketches to the factory because they can be 

misunderstood as seam lines.

To create movement lines, draw random drag lines on the garment. 

Change the weight to .25pt and the profile to width profile 1 (the first 

option in the dropdown menu).



SECTION 4:
COLORING UP

HOW TO COLOR A SKETCH
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To easily color up your apparel flats, always make sure that the sketch 

is grouped and that the outline of the sketch is a closed shape. Using 

the t-shirt example we created earlier, double click on the group to 

isolate it. Click on the outlined shape.

Select a fill color in the swatches panel, your shape will fill with the 

color. If you aren’t seeing some of your stitch/seam lines, select the 

filled shape and right click (PC) or [control+click] (Mac) and choose 

Arrange > Send to Back.

Sometimes, you may need to add more colors to your sketch. The best way to do this is by 

layering colors or textures on top of one another. In this example, let’s make the neck trim a 

different color.

Start by highlighting the anchor points at the front neck piecing on top and bottom using the 

direct select tool [a] and holding shift to highlight multiple points. 



HOW TO COLOR A SKETCH
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Copy and paste in front: [ctrl+c] (PC) or [command+c] (Mac) and then [ctrl+f] (PC) or 

[command+f] (Mac).

Then join: right click (PC) or [control+click] (Mac) and select join (do this twice for both sides).

Then fill with the pop color and change the line color to none.

Bring the seam line and the neck line forward by selecting the green fill and the white fill and 

right click (PC) or [control+click] (Mac) select Arrange > Send to Back.

Repeat these same steps for the back portion. Notice that the green filled shape is at the back, 

causing our outline to be behind the white shapes. 



To remedy this, select the green filled shape then [ctrl+f] (PC) or [command+f] (Mac) and 

change the fill to none. Then, right click (PC) or [control+click] (Mac) select Arrange > Bring
to Front.

HOW TO COLOR A SKETCH
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Creating brushes is an easy way to represent real-life stitches. For example, a coverstitch or 

bartack is very complex and can’t be shown simply with a dashed line. This method is imperative 

when creating construction callouts for apparel sketches. Of course, it can have a lot of other uses

too. Creating texture and decorative borders is a breeze with this method.

Keep in mind you can use the Eyedropper Tool [i] to copy a stroke style, but not a brush style. For 

this reason, I don’t use brushes for my dashed lock stitch, because I would constantly need to go 

to the brushes panel to click on the brush. Using the eyedropper tool is much faster when you’re 

working through a sketch. When using the eyedropper tool on a brush it will choose the stroke 

weight and the dashed line. It will not choose arrowheads or profiles.

Select your “V” shape and go to the brushes window. Select “New Brush” 

from the bottom panel.

SECTION 5:
BRUSHES

INTRODUCTION

HOW TO: CREATE A BRUSH
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Start by determining what part of the pattern you would like to repeat. 

For this example we will be creating a bartack stitch brush. Start with a 

“V” shape at roughly the scale you would like the stitch to be. Create the 

“V” symmetrical and level. I created my “V” with a .15pt line.



Choose “Pattern Brush” and hit “OK”. In the next 

window you can play with sizing, how the brush 

repeats, what your corners look like, and spacing. 

For this brush we will keep the defaults as selected. 

At the bottom of the pop-up widow under 

“Colorization” choose “Hue Shift” from the 

“Method” dropdown menu. This will allow us to 

change the color of the path at any time from the 

swatches panel instead of having to make a new 

brush. You can also name your brush at the top 

of the window. This makes it easier to decipher 

when you have multiple brushes in your library.

Hit OK and the new pattern brush will populate in the 

brushes window. To test if it is repeating as desired, create 

a path and then choose the brush.

You can see that the brush repeats at the edge of the object, it does not overlap, so keep that in 

mind when creating other kinds of stitch brushes. You can change the line weight of the brush to 

make it larger or smaller and you can also change the color.

 

To create a brush that appears as if it overlaps, create a “V” shape that is smooth at either edge. 

Then repeat the same steps as above.

HOW TO: CREATE A BRUSH

WWW.POINTSOFMEASURE.COM | COPYRIGHT POINTS OF MEASURE 2019



To create a brush library, add all of your created brushes to one AI file. Delete 

any unwanted brushes from the brushes window. At the top right of the brushes 

window, click the menu button.

Then select “Save Brush Library” from the dropdown menu.

Save the brush library under Applications > Adobe Illustrator > Presets > en_US > Brushes. To 

test if your library is accessible, click on the library symbol at the bottom of the brushes window. 

In the dropdown menu choose the new library you created.

BRUSH LIBRARY
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Symbols are a great way to make one shape and share it across a lot of different files without 

having to re-create it or open your original file every time. Your symbol library is essential for 

housing zipper pulls, buttons, and brand logo art.  

Next, make 4 smaller circles inside to be buttonholes. You can use the align tools 

at the top of your screen to make sure they are lined up just how you want them.

Select all of the objects and group them (see instructions for 

grouping under the t-shirt flat example). Go to the symbols window

and click on the new symbol button at the bottom.

SECTION 6:
SYMBOLS

INTRODUCTION

HOW TO: CREATE A SYMBOL 
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To create a symbol, first draw a shape. In this example we’ll be creating a button. 

Create a circle using the shape tool at .15pt and at the scale that you want for your 

garment.

Then, make another circle inside by selecting your first circle and hitting 

[ctrl+c] (PC) or [command+c] (Mac) and then [ctrl+f] (PC) or [command+f] (Mac) 

to paste in front, then right click (PC) or [control+click] (Mac) and select 

Transform > Scale. In the “uniform” box choose 80%, then click OK. Change the line 

weight to .05pt.



In the pop-up window choose “graphic” as the export type and “static 

symbol” as the symbol type. You can also name your symbol at the top. 

Naming it makes it easier to find in your library. Hit OK.

You will see your symbol populate in the symbols window. To use this symbol: click, drag, and 

drop it where you want it on your artboard. When using symbols that you want to edit, use the 

“break link” option at the top of document. If you do not break the link it will stay grouped as a 

symbol that you cannot edit. If you choose to edit it, it will edit all instances of the symbol unless 

the link is broken.

To create a symbol library, add all of your symbols to one AI document. Delete

any symbols you do not want to include. Click the menu button at the top of 

the symbol window.

Then select “Save Symbol Library” from the dropdown menu.

HOW TO: CREATE A SYMBOL

SYMBOL LIBRARY

WWW.POINTSOFMEASURE.COM | COPYRIGHT POINTS OF MEASURE 2019



Save the symbol library under Applications > Adobe Illustrator > Presets > en_US > Symbols. 

To test if your library is accessible, click on the library symbol at the bottom of the symbols 

window. In the dropdown menu choose the new library you created.

SYMBOL LIBRARY
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Select your object and go to object>pattern>make.

A pop-up box will appear letting you know that your pattern is 

saved as a swatch in the swatch window. Hit OK. The next 

window is where you will edit your pattern. As a default your 

pattern will be tiled as a grid.

SECTION 7:
PATTERNS

INTRODUCTION

HOW TO: CREATE A PATTERN
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You can easily make any object into a pattern. In this example let’s make a mesh pattern. Note 

that a shortcut is to select your object and drag it into the swatches panel for a quick pattern. 

This shortcut works well with images you are making into a pattern, like a glitter effect that you’ve 

taken from an image.

Start by drawing the repeating part of the pattern. For this mesh we will draw a skinny, 

tall oval that is filled with grey and no outline.



Use the box at the top of the menu to edit the tiling bounds 

(blue square) and space them as far as you’d like. 

Now change the tile type to brick by column to offset your mesh pattern. Note there are other

options for how your repeat is tiled.

At this point make any other changes needed. You can also edit your object in this window. Feel 

free to name your new pattern. Then, at the top menu choose what you’d like to do. For this 

example I’ll click done to save over the swatch that is automatically saved in the swatches panel.

Now you can fill any shape with your pattern by selecting it in the swatches panel.If you want to 

edit your pattern, double click on the swatch and it will return you to the pattern editing window 

you saw at the beginning.

HOW TO: CREATE A PATTERN
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To create a swatch library, add all of your swatches to one AI file. Delete any 

unwanted swatches from the swatches window. At the top right of the swatches 

window, click the menu button.

Then select “save swatch library as ASE” from the dropdown menu. You 

cannot save a pattern or gradient as an ASE file, so if you’d like to save a 

pattern or gradient choose “save swatch library as AI.”

Save the swatch library under Applications > Adobe Illustrator > Presets > en_US > Swatches. 

To test if your library is accessible, click on the library symbol at the bottom of the swatches 

window. In the dropdown menu choose the new library you created.

SWATCH LIBRARY
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Use brushes to create randomized pleats that are on one path. Play with curves and movement 

lines to create volume, ruffles, and darts.

Draw pants with different fits by hugging the curve of the human form, or showing fullness with 

less shape. Add detailed stitch brushes for athletic wear or create a symbol for zipper pulls or bows.

Create detailed zipper pulls and drawcords using symbols for technical outerwear sketches. 

Represent the seams accurately, if they are taped show them taped, if they are clean show them 

clean.
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SECTION 8:
OTHER GARMENTS

RUFFLES, DARTS, & VOLUME

BOTTOMS

OUTERWEAR



.ai = Illustrator file, only those with Illustrator on their computer can open this file for editing, may 

be viewable without Illustrator, includes anything in the file.

.ait = Illustrator Template, use to create a template worksheet. When opened it will come up as a 

new document with your preferences/template already in it. You can then save as your new file 

name. To save over an existing template (for example, when updating a template), choose .ait as 

the file type and save as the same name in the same location. Includes anything in the file.

.svg = Saves any object in the file as a set of paths, used for Cricut/Silhouette machines and the 

web. Will recognize all paths even if they are not visible in the original AI file.

.pdf = Saves only what is visible on the artboard as an image. This is not editable by anyone else. 

Best file format for printing between computers because any text or pictures cannot be corrupted. 

When editing an Illustrator file saved as a .pdf, right click (PC) or [control+click] (Mac) and choose 

“open with Illustrator.”

.eps = Saves any object in the file as an image. Used for the web and best file format for 

transferring to Photoshop. Will recognize all paths even if they are not visible in the original AI file.

Similar to a .jpg. Best used when transferring files between different CAD programs like Illustrator 

and AutoCad.
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SECTION 9:
SAVING

“SAVE AS” FILE TYPES

“EXPORT AS” FILE TYPES

.jpg = Exports all objects in the AI file as images into a separate file.

.bmp = Exports all objects in the AI file as images into a separate file. Best for maintaining the 

quality of the sketch. Bitmaps can be linked into other documents like Indesign.

.png = Exports as an image with a transparent (or white) background. Used for the web.



Image trace is an amazing tool to copy or draw images quickly. It allows you to digitize an image 

in a myriad of different styles and then expand the image into a set of anchor points and paths. 

This allows you to edit the shape, color, or layer it with other images. Specifically for fashion design,

it is a great tool to save time when outlining shapes such as trims or apparel. 

Select the image in the Illustrator file, then go to Image Trace in the 

top menu. The dropdown menu to the right of the button gives you 

options for how you’d like to trace it.
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SECTION 10:
IMAGE TRACE

INTRODUCTION

HOW TO: IMAGE TRACE

BONUS

Start with an image you’d like to copy. Copy and paste it into your AI file. The more simple the 

image is and the higher contrast between the object in the image and its background, the better 

the trace will be. Be cautious to not copy other people’s work. Any copied image should only be

used as a reference to create a shape, do not directly copy someone else’s image. Alternatively,

you can take your own images.

For this example, I will be using an image of a buckle to create a symbol that I can use for flat 

sketches such as backpacks or other accessories. 



Choose your style (I chose Silhouettes, but there are many other styles depending on the effect 

you are trying to achieve) and the object will automatically image trace. 
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HOW TO: IMAGE TRACE

At the top menu choose Expand, your image is now a set of anchor points and paths, including its 

background. Each of the points can be manipulated. You can move them, delete certain colors, 

separate the image, or anything else you want! 

For this example, let’s add the details that we saw in the original photo using smaller line weights

and different stroke profiles to achieve the look of the buckle. First, use the Wand Tool [y] and

click on one of the objects, this will select anything with a black fill, go into swatches and choose

white as the fill color. 

After finalizing the details, you can add your final buckle as a symbol using the instructions from

Section 6.



Similarly, you can also do this with objects in the AI file. For example, if you want to outline your 

text and make it into an object, or make a path into an object. To do this, choose the 

drawing/text/etc. you want to expand. 

Go to Object at the top menu and choose “Expand.” A box will pop-up asking what part of the 

object you want to expand. For this example, choose object and fill and hit OK.

Now your object is expanded. If it is not expanded, go back to object > expand appearance.

The object is now made up of anchor points and paths that are editable.
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HOW TO: EXPAND AN OBJECT


